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Deletion or Modification 
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Quick Reference 
 
Go to the Help Menu and Select a Video to Watch on How to 
Use the Talking Word Processor. 
 

• To Create a New Document   CTRL+N 
• To Open a Document    CTRL+O 
• To Save a Document     CTRL+S 
• To Save As a Different Name   CTRL+F4 
• To Turn On/Off Word Prediction  CTRL+W 
• To Change the Voice Rate    F12 
• To Select a Voice     CTRL+F12 
• To Print the Document    CTRL+P 
• To Exit a Document     ALT+F4 
• To Select All the Text    CTRL+A 
• To Cut Text     CTRL+X 
• To Copy Text     CTRL+C 
• To Paste Text     CTRL+V 
• To Use Find     CTRL+F 
• To Read       F6 
• To Read from the Beginning  CTRL+HOME 

of the Document 
• To Stop Reading     F7 
• To See a Definition of that Word  Double click a word 
• To Select a Word in the Prediction CTRL  

Word List 
 

 
8



The Talking Word Processor 
User Manual 

The Talking Word Processor 
 

The Talking Word Processor is a full functioning word processor with the added 
features of Voice and Word Prediction. With the added benefit of Voice, you can 
do the following:  
 

• Proofread your own documents. 
• Create an Auto summary of your document 
• Hear the words or keys as you type. 
• Increase your reading comprehension by seeing and hearing. 
• Track the word that is being read. 
• Help learn the English language. 
• Word Prediction. 
• Export Word Files Directly To PDF Files 
• Word View. 
• Built-in Dictionary.  Double click any word to hear the definition 

of that word. 
• Talking Grammar Check. 
• Sentence Repeat. Reads the entire sentence when it is complete. 
• Graded Word Prediction. 

 
The Talking Word Processor can work with almost any type of existing word 
processor.  The default document style is Microsoft Word.  However, you can use 
the Rich Text Format style to work with WordPerfect and Microsoft Works 
documents as well. 
 
The Talking Word Processor is an MDI style application.  MDI stands for 
Multiple Document Interface.  This style of application allows you to have more 
than one document open at the same time.  This is a handy feature because you 
may want to copy and paste from one document to another.  If you ever want to 
see which documents you have open, select the Window menu.  At the bottom of 
the Window menu, you will find a list of all the open documents.  Keep in mind 
that only one document at a time is active.  If you have more than one document 
open and you click on the Read button, it will only read the document on the top.  
This is the Active Document.  
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The Screen Layout 

 
The Talking Word Processor has several different parts.  Like most word processors, the 
Talking Word Processor has a Menu bar, Tool bar, Format bar, and Edit area, but it also 
has a Support bar.  The Support bar is a set of tools unique to the Talking Word Processor 
that will help you with your writing. It has features like highlighting, word prediction, 
sentence, and word repeat. 
 
 

 
 
 

Menu Bar Tool Bar 

  
 
 
 
 
The Menu bar is at the top of the window. It contains a list of categories of functions.  If 
you select one of these categories with your mouse or keyboard, the Talking Word 
Processor will display a list of all of the functions or settings available under that 
category.  These functions and settings are described in detail later in this manual. 
 
The Tool bar is a series of icons across the top of the window right below the Menu bar. 
These icons are connected to some of the commonly used functions like Save and Open.  
These commonly used functions are on the Tool bar to increase efficiency because 

Format Bar 
Support Bar 

Edit Area 

Status Bar 
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instead of going to the menu and finding the option, all you have to do is click on the 
icon. 
 
Formatting the text in a document can be done from the menus, but it is easier to do it 
from the Formatting bar.  For example, if you want a different font or font size, all you 
have to do is select the text you want to change and then select the format changes from 
the Format bar. 
 
The Support bar is a toolbar that has tools that can help writers be more efficient. This 
toolbar has a button for highlighting, highlighting color selection, and highlight 
extraction. There are four other buttons on this toolbar:  Prediction, Prediction Options, 
W Repeat, and S Repeat. 
 

 
 
 

The button labeled Prediction  is used to turn the Word Prediction On and Off. 

Turn the Word Repeat On and Off by clicking the W Repeat button .  The S 

Repeat  button stands for Sentence Repeat.  Sentence Repeat will read the entire 

sentence when it is complete. When there is a red X on the button, this feature is 

turned Off.  When there is a green check  on the button, this feature is turned On.  
The idea behind the Support bar is to allow you to quickly turn the support you need On 
and Off as you need it. 
 

The Talking Grammar Check  can also be activated from this bar. Highlight the 
text you want to check and the Grammar Check will check the grammar in just that text. 
Click on the Grammar button without highlighting and it will start from the beginning of 
the document.  For more information on the Grammar Check, see Using the Grammar 
Check later in this manual. 
 
The Support bar can be turned On or Off.  Turned On is the default setting. If you want to 
turn it Off, go to the View menu and select the Support bar option. When there is not a 
check in front of this menu item, it is turned Off.  To turn it back On, just select it again. 
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Highlighting and Extracting Text 
 
The Talking Word Processor has built-in text highlighting.  Highlighting can be used to 
mark points of interest, topic sentences, or as study guides.  There are four different 
highlight colors.  The colors are unique to the Talking Word Processor and will not 
interfere with other colors in the document.  For example, you have a document created 
by a different word processor that has a color already in it, such as yellow headers.  If you 
highlight some of the information in the document, the yellow highlight is unique and all 
other yellows would be ignored. 
 
The four highlight colors are pink, light blue, light green, and yellow. You can set the 

default highlight color from an icon on the Support bar . To change 
the color, just click on the Highlight Color icon.  Every time you click on the color icon, 
it will change.  When it gets to the last color, it will start over again. 
 
To highlight a block of text, first select the text that you want to highlight. Then click on 

the Highlight button .  The text that was selected will be highlighted with the color 
shown on the Color icon.  If you want to change the highlight color of some text, first 
select the color from the Color icon.  Once the desired color has been chosen, select the 
text again and click on the Highlight button. 
 
You can remove any highlighting by selecting the text that has been highlighted and 
going to the Edit menu.  Select the Clear Highlights menu option.  This will remove all 
the highlights in the text, even if the selected text has multiple highlight colors. 
 

Extracting the Highlights 
 

The Talking Word Processor has a feature called Extract .  The Extract 
feature will go through the document, copy the highlighted information, and place 
it into a separate document.  The Extract feature enables you to extract a single 
color or all of the highlighted colors. 
 
To Extract text from a document, go through the document and highlight the 
information that you want to extract. Click on the Extract button. 
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From the Extract Color window, select the color to extract and then click on the 
Extract button.  By default, all the colors are extracted.  The extractor will go 
through your document and copy all the highlighted information into a new 
document.  The extractor tries to keep the formatting of the extracted information 
as close as possible to the original formatting. 
 
When the extraction is done, the information will be placed in a new document.  
This document can be saved like any other file.  The Talking Word Processor can 
also read it. 

 
Creating a Summary of you document 

 
The Talking Word Processor has a built in document summarizer feature. This 
feature allows a reader to reduce the contents of the document to its basic 
essentials. A language modeling system is used to do the summary, giving it a 
higher degree of accuracy over the formula driven models used in the summary 
feature of Microsoft Word.  Because Premier uses language, modeling the 
summary will even be effective on fiction that does not always have the formal 
paragraph structure used in non-fiction writings. 

 
 

How to summarize a document 
 

The summary feature is built into the Talking Word Processor, so you must start 
the Talking Word Processor.  Once the Talking Word Processor has loaded, open 
your document. Once the document is displayed, you will see the support tool bar. 
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Support 
Toolbar 

 

The icon on the far right of the Support Toolbar is the Summarize icon .  
You can select this icon for select Summarize from the edit menu. This will open 
up the summarize window. 

 
 

 
 

You have two choices of how you want the summary; you have one or the other 
or both.  They are Place Summary into a separate document, and Highlight 
Summary in the original document. 
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Place Summary into a separate document.  
 
When there is a check in the Place Summary into a separate document, a separate 
document is created and the resulting summary is placed in it.  This summary can 
be saved or read independently of the original document. 

 
Highlight Summary in the original document. 

 
When the Highlight Summary in the original document has a check mark in it, the 
summary sentences will be highlighted in the original document.  When the 
summary is done, you will be able to look at the original document and see 
exactly where the sentences that were pulled into the summary came from. 
 
There are four choices of colors that can be used by the summary. These colors 
are Yellow, Blue, Pink and Green.  These are the same colors used by the 
highlight and extraction feature built into the Talking Word Processor. This gives 
you a big advantage over other summary tools because once the summary is done 
you can go through, and add things to the summary, just by selecting the text you 
want to add and then click on the high light color.  To remove text from the 
summary select the highlighted text you want to remove and then select Clear 
Highlights from the Edit menu. 

 
This is the first summary tool that allows you to quickly modify the summary.  If 
you want, you can have the Summary Highlight in one color, and then switch 
colors for your highlight, that way you will be able to easily distinguish what was 
in the original and what was not. Once you are done highlighting and you would 
like to create a separate document that contains just the summary use the Extract 
feature on the Support Toolbar. 

 
 

Adjusting the summary size 
 

You can control the size of the summary.  For some documents, you can create a 
summary that is only 10 percent of the original document and some you will need 
a larger summary.  Adjusting the size of the summary will take a little practice to 
meet your needs. To help with this you have two options, you can restrict the 
summary to be a percentage of the original document, or it can be a specific 
number of sentences. 
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The default setting is a percentage of the document.  To switch between 
percentages of the document to number of sentences just select the desired radio 
button.  Once you have made your selection, you can adjust your summary size.  
You adjust the summary size simply by moving the slider to the left to make it 
smaller, and to the right to make it larger.  Just below the slider, you will see the 
percentage or the number of sentences that will be included in the document. 
 
When you have made the selections for your summary just select the Summarize 
button and it will start the summary. The summary process is pretty fast it can 
summarize about 10 pages a second, so a 100-page document will take about 10 
seconds. 

 
 
Viewing a Definition of a Word 

 
To view the definition of any word, just double click on the word to see the 
definition.  The Definition window will open.  You can click on the Read button 
to hear the definition from beginning to end or you can use your Up and Down 
Arrows on your keyboard to read a line at a time.  When you are finished, just 
press the ESC key or click on the Close button. 

 
 

 
 
Using the Talking Grammar Check 
 

The Talking Grammar Check was built from the ground up to support struggling 
writers. Most grammar checks, such as in Microsoft Word, are optimized for 
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accomplished writers and work well at catching those types of mistakes.  The 
Talking Grammar Check is different because it is designed for struggling writers.  
Struggling and new writers make different types of mistakes.  There are over 
2,000 rules built into the Talking Grammar Check, which results in millions of 
different combinations. 
 
In addition to the 2,000 rules, it is broke down into what is call a two pass 
grammar check.  The first pass the grammar check looks for style and structure 
errors, and the second checks for grammar rules. Once your structure has been 
checked – this looks for things like long sentences etc. It will catch some 
grammar rules, but once it is finished with that part it will then go through the 
document again and check the grammar.  It is also important to note that just 
because you ran the grammar check once, does not mean you should not run it 
again.  If you made some changes during the check, you may have created a new 
error that did not exist before. 
 
This is a grammar check, not a grammar correction.  The grammar check will go 
through the document and identify potential problems with the writing; it does not 
mean what has been written is wrong, it will just point out things that should be 
reviewed for correctness.  Many of the times, the simple errors will be caught and 
suggestions will be provided. 
 

 
 
The Talking Grammar Check looks for 29 different categories of grammar when 
looking for errors or potential problems. When the Talking Grammar Check 
locates some questionable text, it will prompt you by asking if it is correct.  It will 
verbally tell you why it may be wrong and provide you with potential options, 
which are read when they are selected. 
 
The Talking Grammar Check works like most other grammar checkers.  Write a 
new document or open up a document to check for grammatical mistakes and then 

click on the Grammar icon  located on the Support bar.  You will be asked 
if you want to check for structure and grammar rules. By default, it looks for both, 
but you can chose to run just one or both. 
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If you have text selected, it will only check the selected text. Otherwise, it will 
start from the beginning of the document. As it is going through the document, it 
will open a Check Grammar window. 
 

 
 
The top part of the window will display the text that is in question and the bottom 
part will list all of the options.  In the area between the two windows, a message 
will be displayed.  This is the message that is read aloud.  Click on one of the 
alternatives in the lower window to have it be read. 
 
The Check Grammar window gives you six different options:  Ignore, Ignore All, 
Change, Undo, Options, and Cancel. 
 
Ignore: Select the Ignore button to skip the current question and go on to the next 
question. 
 
 
Change: This will replace the text in question with the selected replacement 
option from the suggestion window. 
 
Read Again: The read again feature will read the sentence again.  After you have 
made any changes, you can click on the Read Again button and it will read the 
sentence to you again to hear if it sounds right. 
 
Read Description: If you want to hear the description of the problem again, you 
can click on the Read Description button this will read the description of the 
problem again. 
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Undo: If you have selected one of the suggestions and want to go back to the 
original text, select the Undo button. 
 
Cancel: Select the Cancel button to stop the current grammar checking session. 

 
 
 
Document Statistics 

 
When the Grammar Check is complete, it will display the statistics of your 
writing. It will show the number of words, sentences, and characters as well as the 
grade level at which it was written. 

 

 
 

Grammar Check Options 
 

The Grammar Check Options window can be accessed by clicking on the Options 
button from the Check Grammar window or can be displayed by clicking on the 

Grammar Options icon  from the Support bar.   
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There are 29 different categories of grammar rules that can be turned on or off.  If 
there is a check next to one of the rules, that rule is on.  The changes made to this 
window become the default until they are changed again. 

 
 
The File Menu 
 

The File menu is used to manage documents.  Press ALT+F to get to this menu. 
Once at the File menu, you can use the Up and Down Arrows to select the menu 
item you want and then press Enter to activate it. 

 
New Document 

 
There are two ways to start a new document. You can select New from the 
File menu or you can use CTRL+N.  This will create a new document and 
give it the name of “untitled1”. If you have created more than one 
document without naming it, the system will give each document the name 
“untitled1”, “untitled2”, etc. based on the number of unnamed documents 
that you have opened. When you create a new document, it is 
automatically placed on the top.  If you already had a document open, it 
will remain open, but will be underneath the new document. There is also 
a New Document icon in the shape of a blank white document located 
below the Menu bar that you can click on to access a new document. 
 

 
Opening a Document 

 
The Open option is similar to the New Document option because it does 
nothing with the existing document.  It will open the document you have 
selected and place it on top.  All of the documents already open are still 
there and are stacked in the order they were opened.  To open a document, 
select Open from the File menu or hold down CTRL+O. This will open up 
the Open File dialog box.  This is a standard Microsoft dialog box.  There 
is also an icon in the shape of an open manila folder below the Menu bar 
you can click on to open a document.  

 

 
20



The Talking Word Processor 
User Manual 

 
 

Use the Open File dialog box to select the file that you want to open.  The 
default is a Microsoft Word-style document.  If you want to select a 
different type, press the Tab key until you get to get to the File Type drop-
down list box. From this list, you may select from a wide variety of file 
types including Word, HTML, Rich Text Format, and ASCII.  Once you 
have found the file you are looking for, select the OK button and press 
Enter. 

 
 
Close  
 

The Close option is different from Exit. The easiest way to remember this 
is that you close a document and exit an application.  There are safeguards 
built into the Close feature.  If you try to close a document that you have 
changed, you will be prompted to save the changes.  If you have not given 
the document a name, the Save As dialog box will appear, prompting you 
to give the existing document a name.  See the Save As section of this 
manual for more information.  The Hot Key for this feature is CTRL+F4.  
There is also an icon on the toolbar of an open door that will close the file 
when selected.   
 

 
Saving a Document 

 
There are two ways to save a document: (1) Save or (2) Save As.  If you 
have opened an existing document, you can use the Save feature.  You 
will not be prompted for a file name.  If you have not named your 
document before saving it, you will be prompted for a file name and file 
type. When you select Save or Save As, it will only save the active 
document. If you have made changes to more than one open document, 
then you must go to each document and select Save to update that 
document. 
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Save  
 

To save changes to a document, hold down CTRL+S.  You will only be 
prompted if an error occurs when you are trying to save a document.  If no 
message is displayed, the file has been saved successfully.  If you try to 
save a document and have not yet given it a name, you will be prompted to 
do so with the Save As dialog box.  See the Save As section for more 
information.  There is also an icon of a black diskette below the Menu bar.  
Clicking on this icon will save any changes made to the document. 

 
 

Save As  
 

You will see the Save As dialog box in two different situations.  One is 
when you have created a document, but have not saved it yet. When you 
save a document for the first time, you must supply a file name, file type, 
and file location.  By default, a new document is given the name 
“Untitled1”, the file type is “Microsoft Word” and the location is “My 
Documents”.  If the location and the type are correct, all you need to do is 
type in a file name.  The name can be up to 255 characters long with any 
combination of letters and numbers. You do not need to put an extension 
on the file (such as .doc or .txt); the system will automatically do this for 
you based on the type of file selected. 
 
If you attempt to give the file a name that already exists, you will get a 
prompt asking you if you want to overwrite the existing file.  If you select 
Yes, the old file will be gone. 
 
You can also use Save As to copy files.  You can open a document and 
then go to File, select Save As, and give the document a new name.  It 
does not remove the old file; it only makes a copy of it. 
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Exporting A Document To PDF 
 

The talking word processor can directly export the open document to a 
PDF File.  This PDF File is compatible with PDF Equalizer as well as 
PDF Magic.  To export a document go to the File menu and select Export. 

 

 
 

Once the dialog box opens specify a file name and location and select the 
save button. 
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Page Setup 
 

The Page Setup feature allows you to adjust the paper size and margins. 
The default document is Letter size paper (8.5” x 11.0” with 1” margins 
on all sides).  To select a different paper size, select it from the drop-down 
list. You will find most standard types listed. If you do not find one you 
can use, there is a User Defined choice.  The User Defined format will 
allow you to enter any size paper.  When you adjust the paper size, it is 
only for the active document. 

 

 
 
In addition to changing the paper size, you can also adjust the margins. 
The default margin is a 1.0” border on each side. When you make 
changes, it only applies to the active document. 
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Print Preview 
  

The Print Preview menu option will allow you to see what your document 
will look like when it prints. Go to the File menu and then select Print 
Preview to open up the Print Preview window.  
 

 
 

 
The Print Preview screen can display one or two pages at the same time.  
You can also zoom in and out. Select the Next button to go to the next 
page or two. You cannot edit the document in this window.  Click on the 
Print button to print and the Close button to return to the Edit window.  
Under the Menu bar, an icon in the shape of a black document with a 
magnifier can be selected to preview the print job.  
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Printing 
 

You can print a document by holding down the CTRL+P key. This will 
open up the Print dialog box. 

 

 
 

From the Print dialog box, you can select a printer, set the printer options, 
specify the number of copies you want, and the pages you want to print.  
Once you have adjusted your settings, select the OK button to print the 
document.  There is also an icon in the shape of a printer under the Menu 
bar you can click to print.  

 
Exiting the Application 

 
There are two ways to exit the application. The easiest way is to press 
ALT+F4.  This will close the application. Before the application closes, it 
will go through each of your documents to see if any changes have been 
made.  If you have made changes, you will be prompted to save changes 
before you exit the application. 
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Edit Menu 
 
The Edit menu is only available after you have opened or created a new 
document. On this menu, you will find what you need to manipulate text, such as 
the Cut, Copy, and Paste features. 
 
Undo 
 

The Undo function will undo the last change you made to the document. If 
you inserted an image, typed text, or changed formatting, you can select 
Undo and it will restore the document back to what it looked like before 
the last operation. You should note that this function will only undo the 
last operation. 

 
Redo  
 

If you make a mistake when using the Undo function, select the Redo 
function.  The Redo option is only available after you have selected the 
Undo menu item.  

 
Select All 
 

You can select the entire text of the document by holding down CTRL+A.  
This will highlight the entire document.  Be very careful with the entire 
text highlighted because if you press any key, you could delete your entire 
document.  If that happens, however, you can select the Undo command 
and restore your document. 

 
Cut 

 
When you select the Cut feature, it will remove the highlighted text from 
your document and place it on the clipboard.  The clipboard will hold this 
information until the next cut command is activated.  If you select Cut 
twice, only the last information will be retained on the clipboard. The Hot 
Key for Cut is CTRL+X.  There is also an icon of a pair of scissors under 
the Menu bar that you can click to use the Cut feature. 

 
Copy  
 

The Copy feature is very similar to the Cut feature, except that it does not 
remove the highlighted text from the document.  Instead, it makes a copy 
of it and places it on the clipboard.  The Hot Key for Copy is CTRL+C.  
There is also an icon of two cascading pieces of paper under the Menu bar 
that you can select to use the copy function. 

 
27



The Talking Word Processor 
User Manual 

 
 
 
Paste 
 

When you use the Paste feature, it will paste the item on the clipboard into 
your document.  The information from the clipboard will be pasted where 
your cursor is placed.  To paste something from the clipboard, hold down 
CTRL+V.  There is also an icon of a clipboard and paper under the Menu 
bar you can select to use the Paste function.  

 
Delete 

 
When the Delete feature is selected, it will remove all of the selected text 
from the document.  If you hit Delete by mistake, just select the Undo 
menu option. 

 
Highlight 

 
The Highlight feature is used to change the background color of the 
selected text.  This is often used to indicate points of interest or topic 
sentences.  For more information on highlighting text, see the Highlighting 
and Extracting Text section earlier in this document. 

 
Clear Highlights 

 
This feature lets you remove any highlighting in the selected text. To 
remove the highlights, select the text from which the highlights need to be 
removed, and then select the Clear Highlights option.  The colors will be 
removed.  It will remove all highlights even if they are in multiple colors. 
 

Highlight Colors 
 

Use the Highlight Colors option to set the default highlight color.  The 
color that is selected will remain the default until a new one is selected. 

 
Extract Highlights 

 
The Extract Highlights feature will copy all the highlighted text and place 
it into a separate document that can be saved or read. For more 
information on how to extract highlights, see the Highlighting and 
Extracting Text section earlier in this manual. 
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Find 
 

You can search for a word or part of a word with the Find feature. To open 
the Find dialog box, click on the binoculars on the toolbar or hold down 
CTRL+F.  In the Find What edit box, type in the word or partial word you 
want to search.  Before you select the Find Next button, you have two 
choices.  (1) You can select the Match Case check box.  If this is checked, 
the program will only search for words that match both spelling and case 
exactly.  By default, the Find feature will start searching from your current 
location to the end of the document. (2) If you want to search from your 
current location to the beginning of the document, make sure the Search 
Up button is selected.  Select Find Next to find the first occurrence of the 
word and then continue clicking on the Find Next button until you have 
found all occurrences of that word. 
 

 
 

Replace 
 

The Replace feature is very similar to the Find feature.  You can type in a 
word or partial word and search for all occurrences of the word.  The only 
difference is that with the Replace feature you can search for a word or 
phrase and replace it with a different word or phrase.  When you select 
Replace, it will only replace the first found text.  The Replace All feature 
will search from beginning to end of a document replacing the search text 
with what is typed into the Replace With area. 
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Summarize  
 
The Talking Word Processor has a built in document summarizer feature. This feature 
allows a reader to reduce the contents of the document to its basic essentials. A language 
modeling system is used to do the summary, giving it a higher degree of accuracy over 
the formula driven models used in the summary feature of Microsoft Word.  Because 
Premier uses the language, modeling the summary will even be effective on fiction that 
does not always have the formal paragraph structure used in non-fiction writings. 
 

How to summarize a document 
 

The summary feature is built into the Talking Word Processor, so you must start 
the Talking Word Processor.  Once the Talking Word Processor has loaded, open 
your document. Once the document is displayed, you will see the Support 
Toolbar.  
 

 

The icon on the far right of the Support Toolbar is the Summarize icon .  
You can select this icon or select Summarize from the edit menu. This will open 
up the summarize window. 

 
 

 
 

You have two choices of how you want the summary; you have one or the other 
or both.  They are Place Summary into a separate document, and Highlight 
Summary in the original document. 

 
Place Summary into a separate document.  
 
When there is a check in the Place Summary into a separate document, a separate 
document is created and the resulting summary is placed in it.  This summary can 
be saved or read independently of the original document. 
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Highlight Summary in the original document. 
 

When the Highlight Summary in the original document has a check mark in it, the 
summary sentences will be highlighted in the original document.  When the 
summary is done, you will be able to look at the original document and see 
exactly where the sentences that were pulled into the summary came from. 
 
There are four choices of colors that can be used by the summary. These colors 
are Yellow, Blue, Pink and Green. These are the same colors used by the 
Highlight and Extraction feature built into the Talking Word Processor. This gives 
you a big advantage over other summary tools because once the summary is done 
you can go through, and add things to the summary, just by selecting the text you 
want to add and then click on the high light color.  To remove text from the 
summary select the highlighted text you want to remove and then select Clear 
Highlights from the edit menu. 

 
This is the first summary tool that allows you to quickly modify the summary.  If 
you want, you can have the summary highlight in one color, and then switch 
colors for your highlight, that way you will be able to easily distinguish what was 
in the original and what was not. Once you are done highlighting and would like 
to create a separate document that contains just the summary use the Extract 
feature on the Support Toolbar. 

 
 

Adjusting the summary size 
 

You can control the size of the summary.   For some document, you can create a 
summary that is only 10 percent of the original document and some you will need 
a larger summary.  Adjusting the size of the summary will take a little practice to 
meet your needs. To help with this you have two options, you can restrict the 
summary to be a percentage of the original document, or it can be a specific 
number of sentences. 

 

 
 

The default setting is a percentage of the document.  To switch between 
percentages of the document to number of sentences just select the desired radio 
button.  Once you have made your selection, you can adjust your summary size.  
You adjust the summary size simply by moving the slider to the left to make it 
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smaller, and to the right to make it larger.  Just below the slider, you will see the 
percentage or the number of sentences that will be included in the document. 
 
When you have made the selections for your summary just select the Summarize 
button and it will start the summary. The summary process is pretty fast it can 
summarize about 10 pages a second, so a 100-page document will take about 10 
seconds. 

 
Spell Check 
 

The Talking Word Processor comes with an integrated Talking Spell Checker. 

You can access the Spell Checker by clicking on the Spell Checker icon  or 
select Spell Checker from the edit menu.  If you have any word in your document 
that Spell Checker cannot find in its dictionary, it will prompt you with a 
suggestion. 

 

 
 
 

If you want to hear any word in the list, all you need to do is highlight it and it 
will read the word back to you. 

 
Word In Question:  The Word In Question is the word that the Spell Checker 
found in the document that it did not recognize.  To have the computer read the 
word to you, select the Read Original button.   

 
Replace With:  Anything typed in the Replace With edit box will be used to 
replace the Word In Question.  When you select a word from the list, it will 
appear in the Replace With edit box.  To hear what you have typed or selected, 
click on the Read Replace button. 

 
Change:  When you select the Change button, the Word In Question will be 
replaced with the text that has been entered in the Replace With edit box.  It will 
only replace the highlighted word in the document. 
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Change All: The Change All button will replace all occurrences of the Word In 
Question with the word in the Replace With edit box. 

 
Ignore: When you select Ignore, it will not replace the Word In Question.  It will 
skip only that occurrence of the word. 
 
Ignore All: The Ignore All command will ignore all the occurrences of the Word 
In Question and will not prompt you each time it finds it. 
 
Cancel:  This feature will cancel the spell checking of the document. 
 
Thesaurus  
 
The Talking Word Processor comes with its own Thesaurus.  To use it, simply 
highlight the word that you want to find a synonym for and then select Thesaurus 

from the Edit menu or click on the thesaurus  on the support bar.  It will 
open up a dialog box and list the highlighted word in the Looked field. 
 

 
 
To the right of the Looked field is the Replace field.  The word in the Change 
field will replace the originally highlighted word in the source document if you 
select Replace.  The synonym list will display all of the possible words that could 
be used to replace the original.  If you find a word, you want to use, simply 
highlight it and click on the Replace button. 

 
Grammar Check 

 
The Grammar Check works like most other grammar checkers.  Write a new 
document or open up a document that you want to check for grammatical 

mistakes. Click on the Grammar icon  located on the Support bar.  If you 
have text selected, it will only check the selected text.  Otherwise, it will start 
from the beginning of the document.  As it is going through the document, it will 
open a Check Grammar window. 
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The top part of the window will display the text that is in question and the bottom 
part will list all of the options.  In the area between the two windows, a message 
will be displayed.  This message will be read.  Click on one of the alternatives in 
the lower window to have it read. 
 
The Check Grammar window gives you six different options: Change, Ignore, 
Ignore All, Undo, Options, and Cancel. 
 
Ignore: Select the Ignore button to skip the current question and go on to the next 
question. 
 
Change: This will replace the text in question with the selected replacement 
option from the suggestion window. 
 
Read Again: The Read Again feature will read the sentence again.  After you 
have made any changes, you can click on the Read Again button and it will read 
the sentence to you again to hear if it sounds right. 
 
Read Description: If you want to hear the description of the problem again, you 
can click on the Read Description button this will read the description of the 
problem again. 
 
Undo: If you have selected one of the suggestions and want to go back to the 
original text, select the Undo button. 
 
Cancel: Select the Cancel button to stop the current grammar checking session. 
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Grammar Check Options 
 

The Grammar Check Options feature can be accessed by clicking on the Options 
button from the Grammar Check window or it can be displayed by clicking on the 

Grammar Options icon  from the Support bar.   
 

 
 
 

There are 29 different categories of grammar rules that can be turned On or Off.  
If there is a check next to one of the rules, that rule is On.  The changes made to 
this window become the default until they are changed. 

 
 
Prediction Menu 
 

Word Prediction 
 
This menu option is used to turn the Word Prediction feature On and Off.  
When there is a check in front of this option, it is On.  See the Using Word 
Prediction section later in this manual for more information. 

 
Options 

 
To change how the Word Prediction list looks and functions, select the 
Options feature.  Use this feature to change the font size in the Word 
Prediction list, the library to use, and how many characters need to be 
typed before the Word Prediction list appears. For more information on 
how to customize the Word Prediction list, go to the Configuring Your 
Word Prediction section later in this manual. 
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Hot Keys 
 
The Hot Key option displays a diagram on how to use the Talking Word 
Prediction.  To select a word, press the number that corresponds to that 
word or use the Up and Down Arrows to navigate to the desired word. 
Once the word is highlighted, press the CTRL key or double-click the 
word with your mouse. 

 

 
 
View Menu  

 
Outline View shows the document structure. The indentations and symbols in 
Outline View do not affect the way your document looks in Normal View and 
will not appear on the printed version. 
 
Normal 

  
This will keep your layout in the Normal (classic) Full Screen mode.   

  
Print Layout 

  
This will show the layout of the page on your monitor to the left side.  

 
Centered Page Layout 

  
This will center the page on your monitor. 
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Header and Footer 
 

Headers and footers are typically used in printed documents. You can 
create headers and footers that include text or graphics.  For example, the 
page number, date, company logo, document title or file name, or author's 
name are usually printed at the top or bottom of each page in a document.  
All these items can be headers or footers.  A header is printed in the top 
margin; footer is printed in the bottom margin. 
 
You can use the same header and footer throughout a document or change 
the header and footer for part of the document.  As an example, you can 
use a unique header or footer on the first page or leave the header or footer 
off the first page. You can also use different headers and footers on odd 
and even pages or for different parts of a document. 

 
Toolbar 
 

A toolbar can contain buttons with images (the same images you see next 
to corresponding menu commands), menus, or a combination of both. The 
Talking Word Processor includes many built-in toolbars that you can 
display or hide as needed. 
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Support Bar 
 

The Support bar contains direct links to features that help with writing.  It 
includes the Highlighter, Grammar Check, Word Prediction, Word Repeat, 
and Sentence Repeat.  This toolbar is displayed by default. 
 

 
 
Paragraph Bar 

 
The Paragraph bar contains all of the formatting marks for that first 
paragraph. You can change paragraph formatting either by selecting the 
paragraph mark and setting its formatting attributes before you start 
typing, or by typing your text, selecting it along with the paragraph mark, 
and then changing the text's formatting.  

When you press Enter to end one paragraph and begin another, the 
resulting new paragraph has the same characteristics as the previous one. 
For example, to make all the body paragraphs in your document left 
aligned and double-spaced, you only have to set those attributes for the 
first paragraph. Pressing the Enter key carries the formatting over to the 
next paragraph. You can hide or show paragraph marks and other 
formatting marks by clicking on the Paragraph bar. Showing paragraph 
marks helps you see where each paragraph ends and makes it easier to 
select the formatting characteristics you want to change. 

 

 
Ruler Bar 
 

This bar is automatically formatted as shown and allows you to see where 
you are in your document and on your page.  To turn off the Ruler 
function, click Ruler on the View Menu.  
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Status Bar 

The Status bar, which is a horizontal area at the bottom of the document 
window, provides information about the current state of what you are 
viewing in the window and any other contextual information. To display 
the Status bar, click the View drop-down menu and then select Status bar. 

 
Item Shows 

Page The page number of the current page based on the 
page numbers.  

Section  The section number of the page shown in the 
window. 

Ln The line of text where the insertion point is located. 
No measurement is displayed if the insertion point is 
not in the window. 

Col The distance, in number of characters, from the left 
margin to the insertion point. No measurement is 
displayed if the insertion point is not in the window. 

 
 
Control Characters 
 

Control Characters are marks that are inserted right-to-left and in mixed 
text (e.g. Arabic or Asian languages) to specify the formatting of text 
when the inherent directionality of the text is insufficient to display 
expected results. 

 
Zoom 
 

You can zoom in to get a close-up view of your document or zoom out to 
see more of the page at a reduced size.  Go to the View menu, select 
Zoom, and then select Size.  You can also select the Zoom feature from 

the Paragraph bar . 
 

Line Spacing 
 

Line Spacing is a feature that allows you to increase or decrease the space 
between each typed line of text.  To increase the space between lines, go 
to the Settings menu and select Spacing.  A dialog box will be displayed 
with a drop-down list allowing you to select the space between lines, up to 
5X the original layout.  To change the spacing, select the size and then 
click Apply.  If you like the change, select OK.  If you do not like the size, 
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make another selection until you find the setting that you want.  To go 
back to your original setting, select 1X and press the OK button.  
 

                           
 
Word Spacing 
 

Word Spacing is a feature that allows you to increase or decrease the 
amount of space between each word.  To increase the space between 
words, go to the Settings menu and select Spacing.  A dialog box will be 
displayed with two buttons for Word Spacing.  One button is for Decrease 
and one is for Increase.  To do either, select the appropriate button.  The 
program will scroll through the document quickly and make the necessary 
changes.  If you like the change, select OK.  If you do not like the change, 
make another selection until you find the setting that you want and then 
press the OK button.  
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Insert Menu 
 
File 
 

This allows you to select a file to insert in your document. Click on the 
View menu, enter the File Name, and press Open.  

 

 
 

Image 
 

To insert an image into your document, position the cursor where you 
want the image to appear, go to the Insert menu and select Image. You 
will have two options: (1) As Fixed Object or (2) At Caret Position. Either 
option will pull up an Insert Image dialog box. You may select from 
multiple image types.  

 
As Fixed Object:  This inserts the image as an immovable object. Any 
other adjustments you make to the document will not move the image, 
only the elements around it. You will still have the option to manually 
move the image by highlighting it and dragging it to a new location. 
 
At Caret Position: This option inserts the image as a moveable object. 
When you continue to edit your document, the image can be moved along 
with text and other elements. You may also manually move the image by 
highlighting it and then dragging it to the new location.  
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Object 
 

Where Insert Image places a graphic into your document, the Insert Object 
feature allows you to insert graphical or non-graphical elements, such as a 
spreadsheet, video clip, organizational chart, or clip art.  To insert an 
object into your document, position the cursor where you want the object 
to appear, go to the Insert menu and select Object. You will have two 
options: (1) As Fixed Object or (2) At Caret Position. Either option will 
pull up the Insert Object dialog box. You may select from multiple object 
types.  

 
As Fixed Object:  This option inserts the object in a fixed position. Any 
other adjustments you make to the document will not move the image, 
only the elements around it. You have the option to manually move the 
object by highlighting it and then dragging it to the new location. 

 
At Caret Position: This option inserts the object as a moveable element. 
When you continue to edit your document, the object can be moved along 
with text and other elements. You may also manually move the object by 
highlighting it and then dragging it to the new location. 
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Text Frame 

 
The talking word processor supports text frames that can be inserted and 
moved around the document to the desired position.  To insert a text frame 
go to the insert menu and select Text Frame this will insert a text frame at 
the current cursor location. 

 

 
Select the frame to move it or stretch it to desired the location and size. 

 
 
Page Break 
 

When you fill a page with text or graphics, the Talking Word Processor 
inserts an automatic page break and starts a new page. To force a page 
break at a specific location, you can insert a manual page break. 
 

 

 
However, if you insert manual page breaks, you might have to frequently 
re-break pages as you edit the document. You might want to set pagination 
options instead to control where the Talking Word Processor positions 
automatic page breaks. 
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Format Menu 

 
Character 
 

When you select the Character menu item, a dialog box like the one below 
will appear.  From this box, make any changes needed. To apply character 
formatting to a single word, select the word. To apply character formatting 
to several words or a few characters within a word, select the text you 
want to change. 
 

 

 
44



The Talking Word Processor 
User Manual 

 
Paragraph 
 

In the Talking Word Processor, a paragraph is a distinct unit of 
information that has its own formatting characteristics, such as alignment, 
spacing, and styles. A paragraph is always followed by a paragraph mark.  
From the dialog box, select the changes you need.  To keep those changes, 
select OK; to cancel, select Cancel and no changes will be made.  
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Bullets and Numbers 
 

You can add bullets to existing lines of text or you can create a bulleted 
list automatically as you type. If you begin a paragraph by typing a hyphen 
(-) or an asterisk (*) followed by a space or a tab and some text, the 
Talking Word Processor automatically converts the paragraph to a 
bulleted item when you press Enter to end the paragraph.  This type of 
bullet uses a character font. You can add numbers to existing lines of text 
or you can create a numbered list automatically as you type. If you begin a 
paragraph by typing “1.”, pressing the Spacebar or Tab, and then typing 
some text, the program automatically converts the paragraph to a 
numbered list item when you press Enter to end the paragraph.   

You can also choose to increase or decrease the level of the bullets and 
numbers.  For example, if you have chosen the large characters of A, B, C, 
as your bullets or numbering, and you select increase, the next line will be 
increased to the small characters of a, b, c.  If you select decrease, the next 
line will begin with the numbers 1, 2, 3. See the drop-down list for the 
order.  
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Tabs 
 

To select the Tab position, select Tabs from the Format drop-down menu 
and choose the Positions.  To select the desired alignment, click on Left, 
Center, Right, or Decimal. To keep changes, click OK.  To exit, click 
Cancel.  Select Clear to clear one tab or Clear All too clear all tab settings. 

 

 
 
Style  
 

The Style list on the Format drop-down menu, also known as the Style 
Preview, shows many formats associated with your styles. 
 

Attribute Explanation 
Left-indented style 
name 

Shows whether left-aligned text is indented 
negatively or positively from the left margin. 
 

Font size of style 
name 

Reflects the exact font size of the style if it is 
between 8 pt. and 16 pt. Word displays smaller 
type in an 8 pt. font and larger type in a 16 pt. 
font. 
 

Four horizontal lines Represents left, right, centered, and justified 
alignment. 
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Paragraph Frames 
 
Frames are containers for text that can be positioned on a page and sized. 
You must use a frame when you want to position text or graphics that 
contain certain items. To select where you want the frame placed, check 
the appropriate box.  For a frame on the left side of your paragraph, select 
Left.  To put a frame on the right side of your paragraph, select Right.  
The same applies for the other choices of Top and Bottom.  From here, 
you can also select Tab Lines and Styles, such as Connected Frames and 
Double Lines.   
 
In addition, after you have selected your frames, you have the option of 
selecting the width of the line and the distance of the text from that line. 
This can be done using the drop arrows or by clicking into the text box 
and making your change.  To keep your changes, click OK.  To exit 
without keeping changes, click Cancel.  

 

 
 
 

Text Color 
 

Select the text you want changed and then select Text Color from the 
Format drop-down menu.  Choose the color you want and click OK.  To 
exit without making changes, click Cancel.  
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Background Color 
 

Select the area where you want the background color changed.  Select 
Background Color from the Format drop-down menu.  Choose the color 
you want and click OK.  To exit without making changes, click Cancel. 
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Read Menu 
 
Read  

 

To read a document, press the F6 key or click on the Read icon .  
When the reader starts, it will begin where your cursor is located.  To 
make sure your cursor is at the beginning of the document, press 
CTRL+HOME. The system will continue until it reaches the end of the 
document. To stop reading, press the F7 key.  Press the F6 key to resume 
where you left off reading.  There is also an icon of a large mouth on the 
toolbar.  When it is selected, it will start reading the document from where 
your cursor is located. 
 
If you want to spell out a word, use your Left or Right Arrow.  The system 
will read the character that the cursor just moved over.  If you would like 
to only read one word at a time and control the speed at which the Talking 
Word Processor reads, just hold down the CTRL key and press your Right 
or Left Arrow key. Every time you press an arrow key, it will read the 
next or prior word. 

 
Stop Reading 
 

To stop the system from reading, press the F7 key or click on the Stop 

icon .  If you want to continue where you left off reading, press the 
F6 key. 

 
Read Selected Text Only 
 

There are times when you may want to have the Talking Word Processor 
only read what you have highlighted.  To only read the highlighted text, 
highlight the text you want and press the F8 key. 

 
 

Select Voice  
 
The system comes with five standard voices.  You can change the voices 
at any time by pressing the CTRL+F12 key or you can press ALT+T to 
bring up the Settings menu.  You can then select Voices from the menu 
(see next page). 
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You can scroll through the list of voices until you find the one you want.  
As you select a voice, the voice will read to you so you can hear the sound 
of the voice. 
 
Once you have selected the desired voice, you can adjust the Rate by 
moving the first slide bar to the left for slower or right for faster.  Both the 
Rate and Pitch can be adjusted from a –10 to 10, with 0 being the default.  
To hear the sound of your settings, click on the Test button. 
 
You can adjust the Pitch just like changing the voice rate.  Moving the 
slider to the left will decrease the pitch while sliding it to the right 
increases the pitch.  As both the Rate and Pitch are being adjusted, you 
will hear the sound of the new settings. 
 
Select the OK button to close the window and save the changes.  The 
changes that you have selected will be set to the current document.  They 
will also be saved as the default.  The next document you add will have 
these voice settings.  If you do not have a document open, the voice setting 
will be set as the default and will be applied to the next file added to Text 
To Audio. 
 
Selecting the Cancel button will close the window without saving any of 
the changes. 

 
Adjust Voice Rate 
 

You can adjust the Voice Reading Rate two ways.  (1) You can adjust it 
from the Voice window or (2) you can adjust the Voice Rate as it is 
reading.   If you are reading a document and you wish for the Talking 
Word Processor to read faster, just press the F12 key.  Every time the F12 
key is pressed, it increases the reading speed by one notch.  Once you have 
reached the fastest speed, it will go to the slowest speed if you press F12 
again.  Keep pressing the F12 key until you get to the speed you want.  It 
is important to note that some of the speech is buffered, so if you press the 
F12 key, it may take 5 or 6 words before you will notice the increase in 
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speed.  It is also important to note that some voices, like the AT&T voices, 
cannot change speed while reading.   

 
Key Echo 
 

This feature allows you to hear the character just pressed.  To toggle it On 
or Off, click on Key Echo menu item or select it and press the Enter key.  
If it is On, then it will be turned Off and if it is Off, it will be turned On. 
This setting will be saved. 

 
Word Repeat  

 
To use this feature, select Word Repeat from the Read drop-down menu.  
When selected, this feature allows you to hear the word just typed.  
Example: Type the word “Monkey” and then press the Spacebar.  You 
will hear the word “Monkey”.  To turn this feature Off, de-select Word 
Repeat from the Read drop-down menu.  

 
Sentence Repeat 

 
This feature will read the sentence back to you as soon as you finish it.  It 
can be turned On or Off by selecting this menu option. When there is a 
check in front of this option, it is On. 

 
 
Reading Options 
 
 

The Reading Options menu will open up a window allowing you to make a whole 
host of changes to your reading environment.  Select Reading Options from the 
Read menu to open the Options dialog box. 

 

 
 

 
52



The Talking Word Processor 
User Manual 

There are three tabs on the window: Screen Settings, Tracking and Highlighting, 
and Word View Settings. 

 
 

Screen Settings 
 

On the Screen Settings tab, you can change the background color, foreground 
color, set the default zoom level, and change font size.  You can also set the 
default folder where you would like all of your documents to be saved. 

 

 
 
 

Changing Screen Colors 
 

You may prefer to change the foreground and background colors to make reading 
easier. You would do this from the Screen Settings tab.  To change the colors of 
your screen, just select the desired color from the drop-down list.  To the right of 
the drop-down list, you will see the color change as you make your selection. This 
will give you an idea of what your color choices look like. There are about 36 
different color combinations. 

 
Zoom Factor 

  
You can set a default magnification level.  This default level will be used 
whenever you start the Talking Word Processor.  Once it has been started, you 
can change it, but the next time you start the Talking Word Processor, it will 
return to the default. 

 
 
Place All Documents Here 

 
You can set the default location for opening and saving documents.  If you set the 
location, every time you click on Save or Open, it will look first in this folder 
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location.  To set the location, click on the Browse button.  A directory list will 
open. 

 

 
 

Select the drive and the folder you want to be your default location and click OK.  
This will set your default path. 

 
 

Tracking and Highlighting 
 

Use the Tracking and Highlighting tab to set your reading preferences.  These 
features are only noticeable while the Talking Word Processor is reading to you. 

 

 
 
 

Highlighting 
 

The Talking Word Processor now supports multiple forms of highlighting.  
You can have the Talking Word Processor highlight by word only, by 
word and sentence, and by word and paragraph.  The highlight colors are 
selectable to meet your visual preference. 
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Highlight by Word 

 
Highlight by Word only highlights each individual word that is being read.  
It will follow along as the document is being read.     

 

 
 

To select Highlight by Word, go to the Read menu, select the Highlight 
menu item, then select the sub-menu item Highlight by Word, and press 
the Enter key.  If there is a check mark in front of it, this feature is turned 
On. 

 
Highlight by Sentence and Word 

 
Select this option if you want to have the current sentence highlighted as it 
reads to you.  It highlights both the current sentence as well as the word 
that is being read in that sentence.  The sentence is highlighted in one 
color and the current word is highlighted in a contrasting color.  You can 
select the Highlight Color. See Changing the Highlight Color later in this 
section. 

 

 
 
 

Highlight by Paragraph and Word 
 

If you want to have the current paragraph highlighted with a contrasting 
color of the current word being read, make sure that there is a checkmark 
in front of the Highlight by Paragraph and Word menu option.  You will 
find the highlight options on the Read menu.  The colors of the highlight 
are selectable. 
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Identifying Word Being Read 
 

The Talking Word Processor gives you two methods of identifying the 
word being read.  (1) You can have the word highlighted or (2) you can 
have the color of the word change.   The default is highlighting the word. 

 
Change Word Color 

 
If you would prefer to have the word change color as it is being read 
instead of having it highlighted, as it is being read, make sure the Change 
Word Color option is selected.   If you do select this option, make sure 
that you select a different color from the original text.   If you select black 
and your text is already black, you will not be able to see the word color 
change.  If you select the same color as the background, the word will 
disappear as it is being read.   

 
Word Pause  

 
This feature allows you to slow down the reading of the word without 
distorting the word being spoken.  You can increase the time between each 
word. This will allow you time to comprehend the word before going on to 
the next word.  It is a great feature for people learning to read or studying 
a new language.  To use this feature, place a check in the Enable Word 
Pause check box. 

 
Word Pause Setup 
 

If you have enabled Word Pause, you will also want to select a word pause 
length.  This is the length of time between spoken words. The time can be 
adjusted from 0.25 to 3 seconds. 
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Word View Tab 
 

Word View is a visible window that remains stationary on your computer screen 
while the document is being read.  Some people have trouble following a moving 
cursor or rolling text, so we made a stationary window that allows you to focus on 
a single place on the screen for reading.  The Word View window will display 
EACH word that is being read.  It is always displayed in the same spot, so you do 
not need to move your eyes.  It also gives you the ability to change the font size, 
background color, and text foreground color independent of the document being 
read.   

 
 

 
 
 

Word View Settings 
 

To change the settings of the Word View window, go to the Read menu 
and select Reading Options. Then select the Word View tab.  From this 
window, you can adjust the font size.  You can select from 8 to 24 point 
font.  When you select a font size, you will see the sample text change to 
reflect the new setting. You can also change the Background Color and the 
Text Color.  You do not need to save the changes.  All you have to do is 
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select the Close button and the options that you have selected will 
automatically be saved for the next time you read. 

 

 
 
 

Show Word View 
 

Place a check in the Display View check box.  This will display the Word 
View window while the Talking Word Processor is reading.  Remove the 
check if you want to turn off the Word View settings. 
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Table Menu 
 

A table is made up of rows and columns of cells that you can fill with text and 
graphics. Tables are often used to organize and present information, but they have 
a variety of other uses as well. You can use tables to align numbers in columns 
and then sort and perform calculations on them. You can also use tables to create 
interesting page layouts and arrange text and graphics.  

 
Insert 
 

This allows you to insert a table.  A dialog box like the one below will 
appear and you can select the number of rows, columns, or both needed.  
Click OK to keep the table attributes. To exit without creating a table, 
click Cancel. 

 

 
 
Select 
 

This option allows you to select a row, a column, or the entire table to 
make changes.  Create a table and select from the drop-down list which 
part you want to modify (table, row, or column), and then make your 
changes.  

 
Delete 
 

This allows you to delete a row, a column, or the entire table.  To delete, 
click inside the table, then select from the drop-down list the item you 
want to delete.   

  
Grid Lines 
 

If this is checked, all grid lines will be shown on the table.  If it is not 
checked, no grid lines will be visible. 
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Properties 
 
The dialog box below allows you to change any properties of the table from the 
width of each line to the background.  To save changes, click OK.  To exit 
without saving changes, click Cancel.  
 

 
 
 
Options Menu 
 

Use the Options Menu to set the default font and font size for the Talking Word 
Processor. To set the default font and font size for all new documents go to the 
“Option” menu and select Default Settings. 
 

 
 
When the dialog box opens select the “Select Defualts” button.  This will open the 
font dialog box. 
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Select the Font and Font Size you want as the default and then select OK.  You will be 
returned to the default window.  If you select OK this will become the new defaults for 
all new documents and set the current font and font size to this new defaults.  If Cancel is 
selected the window will close and the defaults will not change. 
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Window Menu 
 

This menu shows the way the window is presented on the screen.  See below for 
examples of the different layouts.  
 
Cascade 
 

This shows the open windows in drop-down layers with the most recently 
used application window in the front. 
 

. 
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Tile Horizontally 

 
This view shows the open windows directly horizontal to one another and 
the one most recently used will be on top.  
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Tile Vertically 
 
This view shows the open windows directly vertical or side-by-side to one 
another with the one most recently opened highlighted to the far right.  

 

 
 
Arrange Icons 

 
This feature will arrange the icons on your menu and toolbars.  
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Help Menu 
 

This entire manual is located in the Help file. There are three ways to open the 
Help menu.  (1) Press F1, (2) select the Help icon on the toolbar (a purple book 
with a question mark on it), or (3) press ALT+H.  This Help file is in the 
traditional Microsoft Windows Help File format. 

 
Contents 
 
 This feature allows you to get the contents of the Help file.   
 
Load User Manual 
 
 This will load the User Manual onto the screen for you to read. 
 
Training Videos on how to use the Talking Word Processor 
 

The Talking Word Processor now has built-in videos.  If you ever want to 
see how to use the Talking Word Processor, go the Help menu and select 
one of the videos.   
 

 
 
The videos are 
 

1. Introduction to the Talking Word Processor 
2. Writing With the Talking Word Processor 
3. Summarizing in the  Talking Word processor 
4. Using the Talking Grammar Check 
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About 
 

The About Help box is a small window that tells you which version 
number you have and contact information.  To open the About window, 
press ALT+H to open the Help menu and then select About.  To exit this 
window, press the Enter key. 
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Using Word Prediction  
 

Configuring your Word Prediction 
 
The Predictor Pro Word Prediction can be easily configured to best suit your 
needs. You can change the font size of the Prediction List, edit the word list, and 
even set the minimum number of characters you want to enter before it displays 
the Prediction List. 
 
Select the Options item from the Prediction menu.  This will open up the 
Prediction Settings window. 

 

 
 

Word List Font Size 
 
You have the choice of 3 different font sizes for your Prediction List.  The Small 
size is a 10-point font and is the default.  The Medium size is a 12-point font and 
the Large is a 14-point font.  Click on the button next to the size you want. 

 
Libraries 

 
The new Predictor Pro comes standard with two libraries:  English Unabridged 
and English Abridged.  For the most part, both libraries contain the same 
information, with the exception being that most of the offensive, vulgar, and 
obscene language has been removed from the abridged dictionary. 
 
You are not limited to the words provided in the libraries.  You can edit words, 
add your own words, and even delete words you do not want. To view the words 
in the library, select the library you want and then select the View Library button. 
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Display List After 

 
Word Prediction will provide you with a floating word list.  As you type, the list 
floats along displaying the predicted words.  The more characters you type, the 
more accurate the predicted words will be.  It is rare that the prediction can 
predict the word you are looking for with just one character.  That is why we give 
you the option of displaying the word after you have typed a set number of 
characters. The default is 2 characters, but you can make it any value you choose.   
 
Display number of words in list 
 
You can select the number of words being displayed in the word list.  This is the 
maximum number of words that will be displayed per page. The Talking Word 
Prediction has two pages; the first page background is blue and the second page is 
red.  
 
Place a space after a selected word 
 
When you select a word from the prediction word list, it will insert the word. If 
you have a check in this check box, it will automatically put a space behind the 
word.  Leave it blank if you do not want a space. 
 

 
Saving Your Word Prediction Settings 

 
When you are done making your adjustments, just select the OK button.  The 
options that you have selected will automatically be saved.   When you open up 
the Word Prediction Options window, it will display your current configuration. 
When you close the window, the changes you have made will now become the 
default configuration. 
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Modifying the Libraries 
 

Select the View Library button from the Prediction Options window to edit the 
word libraries.  This will open up the Edit Word List window.  When it opens, all 
the words will be displayed in alphabetical order.  The abridged and unabridged 
dictionaries contain 80,000 of the most commonly used words.  In addition to 
commonly used words, it also includes over 1,100 commonly misspelled words 
and phonetically spelled words. 
 
Remember the old grammar rule of “i” before “e” except after “c”.  
Unfortunately, that is only good most of the time.  For example, the word “weird” 
is an exception to that rule.  Word Prediction will pick up these misspellings and 
provide you with the correct word.  The same thing will happen if you 
phonetically spell “phone” with an “f” like “fone”.  Word Prediction will detect 
that as well and offer the correct spelling. 

 

  
 

Click to Search for 
a Word 

 
 

 
In the Library Table view, you will also see a Usage column.  The Usage column 
is how often the word is used in the English language.  The larger the usage 
number, the higher on the Prediction List it will appear. 
 
You can add your own words and even abbreviations to the Prediction List.  For 
example, the name of your organization may be quite large- “Traverse City 
Intermediate School District”.  You can enter the shorthand of “TCISD” and 
every time you type those five letters, it will be replaced with “Traverse City 
Intermediate School District”, thereby, saving you a significant amount of typing.  
For more information, see Adding Words to the Library section later in this 
manual. 
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Show Modified Words Only 

 
There is a check box called Show Modified Words Only.  When this is checked, it 
will only show the words that you have added or modified.  It gives you a quick 
way to review all your custom words. 

 
 

Commonly Misspelled Words 
 

In addition to the regular library of correctly spelled words, we also provide you 
with a list of commonly misspelled words.  To see this list, put a check in the box.  
If you have words that you often misspell, you can add them as well.  In that 
manner, when you misspell those words, you will be prompted with the correct 
spelling. 

 
Prediction Levels 

 
Not all writers write at the same level.  Therefore, the Word Prediction does not 
assume that everybody needs the same words.  The Word Prediction can be 
adjusted based on the grade level at which you are attempting to write.  The preset 
grade levels are 4, 6, 8, and All Grades. 
 

 
 
When a grade level is selected, it will try to predict at the selected grade level and 
below. Set the Prediction Grade Level by selecting the Option button next to the 

Prediction button on the Support bar. .  This will open up the 
Prediction Library List.  You can change the Prediction Level at any time.  This 
Prediction Level will remain the default until it is changed.   
 
The words can be moved from one grade level to another. If a word is not in the 
grade level, you want, i.e. it appears in the Grade 6 and below group, but you 
want it to be in the Grade 4 and below group, all you have to do is increase its 
usage value.  To move a word from a lower group to a higher group, you must 
decrease its usage value. 
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Adding a Word to a Library 
 

To add a word to a library, you need to have the dictionary open.  You can do this 
by selecting the Options menu item from the Prediction menu in the Talking 
Word Processor.   Once the Options menu is open, select one of the libraries. 
 

 

 

Select a library 

 
Then, select the View Library button.  This will open the Edit Word List window. 

 

 
 

To add a word, select the Add button.  When you select the Add button, the Add 
Word window will open. 
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When adding a word, you have two places to type in the word.  You have the Add 
Word edit field where you can enter the correct spelling of the word.  This is the 
word that will be displayed in the Prediction List.  The second field is the 
Alternative Spelling.  This field allows you to enter in an alternative spelling for 
the correctly spelled word.  For example, if you constantly misspell the word 
“tomorrow” as “tomorow”, you can enter your alternative spelling and then every 
time you misspell it, you will be prompted with the correct spelling of the word. 

 
The Alternative Spelling feature can be used for many different things.  You can 
use it as shorthand or the phonetic spelling of a word.  For the word “phone”, you 
could enter in the alternative spelling “fone” and then anytime the word is spelled 
phonetically, the correct word would appear in the list. 

 
Word Usage.   Not all words are created equal.  Some words are used more 
frequently than others.  For example; the word “antelope” is not used as often as 
the word “anticipate”.  Therefore, if you type in the first few letters, you would 
want “anticipate” to be higher on the list than “antelope”.  You can provide a 
usage value to any word you add to a list by moving the slider bar from the left to 
the right. 
 

 
 
 
The default is zero.  The higher the value you give a word, the higher it will be 
displayed on the Prediction List. Higher value words appear higher on the list than 
words that have a lower value, but similar spelling. 

 
You can use this feature to adjust words already in the library.  If you do not want 
a word to appear on a list, you can completely remove the word from the library 
or you can give it a usage value so low that it will only display when all other 
options have been exhausted. 
 
When you have finished adding a word, select the OK button. 
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Removing a Word from a Library 

 
To remove a word from a library, you need to first have the library open.  Once 
the library is open, you will need to find and select the word you want to remove.  
You can tell what word you are on by the arrow next to the word. 
 
 
 
 
 
 

 
 

To remove the word, just select the Remove button. Caution: This is permanent.  
Once you have removed a word, it is gone forever.   The only way you can get it 
back is to manually add it back in. 

 
 
Using Word Prediction 
 
 

You can use Word Prediction without having to make any changes to the 
configuration.  Just turn it on and start typing.  If you would like to change the 
prediction settings, go to the Prediction menu and select the Options item. 

 
Turning Word Prediction On or Off 
 
By default, Word Prediction is Off.  You need to turn it On before you start using 
it.  Once it is turned On, it will remain On until it is turned Off again.  If you have 
Word Prediction turned On when you exit the Talking Word Processor, it will be 
On the next time you use the Talking Word Processor. 
 
To turn Word Prediction On, go to the Prediction menu in the Talking Word 
Processor and select the Word Prediction menu option.  You can also press 
CTRL+W to toggle it On or Off.  If there is a checkmark in front of the menu 
option, then Word Prediction is On. 
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How Do I Use Word Prediction? 

 
Once you have Word Prediction turned On, all you have to do is start typing!   As 
you type, the floating Prediction List will appear and follow your cursor as you 
type. 

 

 
 
When the word list is visible, you can hear the words in the list by using your Up 
and Down Arrow keys to go through the list.  
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Selecting a Word from the Word List 

 
Use your Up and Down Arrow keys to go up and down the list. As each word is 
highlighted, it will be read to you.  There are three ways to select the word to 
insert into your active document as you are typing.  (1) You can simply double-
click the word with your mouse, (2) press the CTRL key on your keyboard, or (3) 
press the corresponding number in front of the word you want.  In the following 
example, you would press the number 6 to select the word “typing”.   The 
numeric keypad will not work for selecting these words.  You must use the 
number keys above the letters on your keyboard. 

 
 

 

Press the 6 or 
the CTRL key 
to select the 
word 

 
 
 

How to Get the Right Word Every Time 
 

Predicting a word is great, but how do you know if it has selected the right word?  
It is easy with the Talking Word Processor.   If you would like to find a definition 
of a word in the Prediction Word List, select the word with your mouse and then 
click the right mouse button once.  When you do that, the Definition window will 
open. 
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When the definition appears, just click on the Read button to hear it. You can also 
use your Up and Down Arrows to read a line at a time.  When you are done, just 
press the ESC key or click Close. 

 
Find the Definition of a Word by Double-Clicking the Word 

 
If you would like to find a definition of a word, just double-click the word in the 
Talking Word Processor.  When you double-click a word, the Definition window 
will open.  Then click on the Read button to hear the definition.  When you are 
done, click the Close button or press the ESC key. 
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Appendix A - System Requirements 
 
 
 

System Requirements 
 

Windows: XP home/Pro, Vista 
CPU:   900 MHz Pentium or Faster 
Memory:  256 MB 
Disk space:  60 MB 
CD ROM:  4X or Faster 
Keyboard:   104-key Standard Keyboard 
Mouse:  Standard Mouse 
Speakers:  Standard Speakers 
Sound Card:   Any Windows Compatible Sound Card 
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